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Before You Continue

Before You Continue
This release upgrades 12.5 installation of MapInfo Professional to version 12.5.2. Follow the instructions
provided in this document under Upgrading MapInfo Professional.

Upgrading MapInfo Professional
Your computer must be connected to the Internet to download the 12.5.2 MapInfo Professional
Maintenance Release.
You may install this Maintenance Release provided the following product is already installed on your
computer:
• MapInfo Professional 12.5
• MapInfo Professional Runtime 12.5
If both of these products are installed, then the installer upgrades them at the same time. You do not
need to run this installer multiple times.

Installing MapInfo Professional 12.5.2
You must have Administrator rights to run the Installer, and the Installer requires that your TEMP
environment variable be set to a valid directory.
To upgrade MapInfo Professional to version 12.5.2 Maintenance Release:
1. From the MapInfo Professional Main menu, select Help > Check for Update. The Maintenance
Releases for MapInfo Professional web page displays.
2. On the web page, click the download link and follow your web browser's instructions for opening and
running the patch file. The file is called MapInfoProfessional12.5.2MaintenanceRelease, should you
choose to save and run it later.
3. Follow the instructions to complete the upgrade. It is important to wait until the installation completes.

Advanced Installation for System Administrators
This section is for the system administrator installing this Maintenance Release using a command line,
and the network system administrator installing this Maintenance Release across the network using a
Microsoft Patch (MSP) file.

Upgrading in Silent Mode
To run the MapInfo Professional Maintenance Release installer in silent mode, from a command prompt
change directories (cd command) to where the Maintenance Release .exe file is, and then type:
MapInfoProfessional12.5.2MaintenanceRelease.exe /s /v"SILINST=True"
Where:
• /s = runs the setup.exe silently
• /v = passes the parameter "SILINST=True" into the setup.exe to suppress the GUI.
A progress dialog box may display during the installation.
You may see a prompt for permission to continue. Click Allow or OK to proceed.
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Microsoft Warning for 64-bit Version of Microsoft Office
If you do not have Microsoft Office installed on your machine, then MapInfo Professional 12.5 installs a
Microsoft Office 2010 32-bit driver, so that MapInfo Professional can open Microsoft Access and Excel
2010 files.
If you already have the 64-bit 2010 Microsoft Office driver installed, and you do not have the 2007 32-bit
driver installed, then MapInfo Professional installs the Microsoft Office 2007 32-bit driver. You can still
work with Microsoft Access 2010 and Excel 2010, but you may see an error message if an incompatibility
occurs.
Note: Microsoft strongly recommends using the 32-bit (x86) versions of Office 2010, Project 2010,
Visio 2010, and SharePoint Designer 2010 applications as the default option for all platforms
(including on a 64-bit operating system).

License Server Utility
If you have a previous version of the License Server Utility (LSU) installed to manage distributable
licenses, then you must upgrade to the latest License Server Utility, version 4.5. Using a previous version
of the License Server Utility with MapInfo Professional 12.5 will cause MapInfo Professional to become
unresponsive.
Using an incompatible version of the License Server Utility might result in the following issues while
fetching licenses for MapInfo Professional:
• MapInfo Professional is unable to borrow a license.
• MapInfo Professional is unable to activate a distributed license from the License Server.
If this occurs, contact your License Server administrator and have them upgrade the License Server to
version 4.5.
After successfully borrowing or activating a license, if you again roll back to an older version of License
Server Utility, you can not transfer the borrowed/activated license back to License Server Utility. You
will not see an error message as the operation simply hangs.

Repairing MapInfo Professional from the .MSI file
The repair process fails using the .msi file when the Microsoft User Account Control (UAC) is turned on.
Depending on the installation conditions the repair stops with the following error message:
You have MapInfo Professional running, please close it and run
setup again.
To work around this issue, do one of the following three things:
• Shut off the UAC (User Account Control), this requires System Administrative privileges, reboot
the machine, and rerun the repair.
• Run the original setup.exe file and then run the repair from maintenance mode.
• Run the installed copy of the MapInfo Professional 12.5 .msi file as an administrator. Go to
C:\Windows\Installer and search for the MapInfo Professional 12.5 .msi file. It will have a
name similar to 8e95f1.msi, where the name is different for each machine. Go to
C:\Windows\System32 and find the cmd.exe file. Right click this file and select Run as
Administrator (this may require an administrator password). Run the command
C:\Windows\Installer\nameofMiPro12.5.msi and select Repair from maintenance mode.

Disabling User Account Control (UAC) on Windows 7 or Server 2008 R2
To disable UAC on Windows 7 or Server 2008 R2:
1. Launch MSCONFIG by from the Run menu.
2. In the System Configuration dialog box, click the Tools tab.
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3. Click Change UAC Settings.
4. Click Launch.
5. Move the slider to Never Notify.
6. Click OK to close the dialog box.
7. Reboot the machine to have this change take effect.

Disabling User Account Control (UAC) on Windows 8 or Windows Server 2012
To disable UAC on Windows 8 or Windows Server 2012:
1. • On Windows 8, go to the Search Charm and type Change User Account Control settings.
• On Windows 2012, on the Control Panel, select User Accounts, and click on Change User
Account Control Settings.
2. In the User Account Control Settings console, move the slider to Never Notify.
3. Click OK.
You may see a prompt to confirm your selection or to enter an administrator password.
4. Reboot the machine to have this change take effect.

Support Notices
SQL Server 2012
If connecting to a SQL 2012 server with Windows 7 or higher, use the SQL Server Native Client 2012
(also known as SQL Server Native Client 11.0).
Bing Maps Expiration Date
Bing Maps has a limited license period, which is specific to each version of MapInfo Professional. The
Bing Maps and the Add Bing Roads to Map and the Move Map To features cease working after this date:
• MapInfo Professional 12.5 on January 1st 2016
• MapInfo Professional 12.0 on January 1st 2015
• MapInfo Professional 11.5 on January 1st 2014
Customers with a current maintenance package who would like to continue to use earlier versions of
MapInfo Professional (10.5.3, 11.0.x, 11.5.x, or 12.0.x) are entitled to use Bing services until January
1st 2016. For details, contact your account representative.

Downloading Tools and Applications
Several tools and applications are available for download from the Pitney Bowes Inc. website at
www.mapinfo.com.
MapInfo ProViewer www.mapinfo.com/proviewer
MapInfo ProViewer lets anyone open, view and manipulate your MapInfo Pro
maps, tables and analyses with easy-to-use functionality including print, zoom,
scroll, select objects, measure distances and view details.
MapBasic

www.mapinfo.com/mapbasic
The MapBasic development environment is a complete, BASIC-like programming
language used to create custom applications for use with MapInfo Professional
or special MapInfo Runtime. MapBasic allows you to customize the geographic
functionality of MapInfo Professional, automate repetitive operations and integrate
MapInfo Professional with other applications.

EasyLoader
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EasyLoader lets you to upload Professional .TAB files to a remote database, such
as Oracle, SQL Server, Microsoft Access, and PostgreSQL / PostGIS.
To install these downloads, unzip the download file in to your Temp folder (C:\Temp) and then launch
the setup.exe. An install wizard guides you through the installation process.
To obtain more MapInfo Professional resources and downloads, visit www.mapinfo.com/resources.

Locating Your Documentation
MapInfo Professional documentation, in the form of PDF files, installs with MapInfo Professional in to
the Documentation subfolder. You must have the Adobe Acrobat reader installed to view PDF files.
To download a free copy of the Adobe Acrobat Reader, go to http://www.adobe.com.
Installation Instructions are Available in the Install Guide on the DVD
For system requirements, installation instructions, and System Administrator notes for performing a
workgroup installation, see the MapInfo Professional Install Guide. You can view this document from
the DiscStarter application, which launches automatically when you insert the MapInfo Professional DVD
in to your machine’s drive. From the DiscStarter application:
• Click Reference and then MapInfo Professional Install Guide, or
• Click Browse DVD. This launches an Explorer window. Under the PDF_DOCS folder, double-click the
MapInfoProfessionalInstallGuide.pdf file.
Instructions for Activating your License are in the Install Guide
Instructions for activating your MapInfo Professional license are in the MapInfo Professional Install Guide.
The same information is also in the MapInfo Professional Licensing and Activation Notes
(ActivatingYourProduct.pdf).
The MapInfo Professional Data Directory Document is on the DVD
MapInfo Professional’s sample data comes with the MapInfo Professional Data Directory document,
which describes the sample data. You can view this document from the DiscStarter application, which
launches automatically when you insert the MapInfo Professional DVD into your machine’s drive. From
the DiscStarter application:
• Click Reference and then MapInfo Professional Data Directory, or
• Click Browse DVD. This launches an Explorer window. Under the PDF_DOCS folder, double-click the
MIProDataDirectory.pdf file.
All Documents Install with your Software
After installing MapInfo Professional, you can find documentation files under the Documentation folder
where MapInfo Professional is installed (for example, C:\Program
Files\MapInfo\Professional\Documentation).
Documentation is also available on our website at www.mapinfo.com/miprodocs.
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Notes about this Release
New Features in MapBasic
For details about new and enhanced features in this release, see the What’s New in MapInfo Professional
chapter in the MapInfo Professional User Guide or MapInfo Professional Help System.
The following features have been added/updated in MapBasic:
Capability to read a workspace created in MapInfo Pro 12.5.1 64-bit
MapInfo Pro 12.5.1 64-bit was essentially a new version of MapInfo Professional and added several new
MapBasic constructs.
For MapInfo Professional 12.5.2, we have added the capability to process these new constructs. Therefore,
MapInfo Professional 12.5.2 can read a workspace created in MapInfo Pro 12.5.1 and execute MapBasic
programs created with MapBasic 12.5.1 without any error.
This is achieved by ignoring constructs that do not make sense, including the new window states such
as, Floating, Docked, Tabbed, Hide, and Autohide. The new windows added to MapInfo Pro 12.5.1 64-bit
such as, Workspace Explorer, Window List, Tool Manager, Task Manager, and Connection List are also
ignored. Constructs that were added concerning the loading and saving of workspaces are also ignored,
for example, Mode Current.
We also added WIN_INFO_CLIENTWIDTH (50) and WIN_INFO_CLIENTHEIGHTT (51) to the WindwoInfo
function for MapInfo Pro 12.5.1, but they will not return useful information in MapInfo Professional 12.5.2.
Removing frames from Layout Designer windows
You can delete frames from Layout Designer windows using the MapBasic program. The Remove
Designer Frame statement, which originally worked only on Legend Designer windows, can now be used
on Layout Designer windows as well. If the Window clause specifies a Layout Designer window ID, the
statement removes frames from that Layout.
If you omit the Window clause, the statement operates on the frontmost window, or the frontmost Legend
Designer window, or the frontmost Layout Designer window as the case may be.
Altering Text frames in Layout Designer windows
MapBasic programs can now alter text frames from Layout Designer windows. The Alter Designer Text
statement, which originally worked only on Legend Designer windows, can now be used on Layout
Designer windows as well. The MB Syntax is has not changed. But it now supports text frames in the
Layout Designer.
The following statement can be used to alter the text string, font style, or text position.
Alter Designer Text
[ Window window_id ]
[ ID textframe_id [
[ Text frame_text ]
[ Font... ]
[ Position ( x, y ) [ Units paper_units ] ] ] ]
If you omit the Window clause, the statement operates on the frontmost open window, or the frontmost
Legend Designer window, or the frontmost Layout Designer window.
Altering frame position in Layout Designer windows
MapBasic programs can now alter frame positions from Layout Designer windows. The Alter Designer
Frame statement with the Position clause can now be used on Layout Designer windows as well. The
MB Syntax has not changed but it now supports moving frames in the Layout Designer using the Position
clause.
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The following statement can be used to alter the layout designer frame position.
Alter Designer Frame
[ Window legend_window_id ]
Id { frame_id }
[ Position ( x, y ) [ Units paper_units ] ]
[ Title [ frame_title ] [ Font... ] ]
[ SubTitle [ frame_subtitle ] [ Font... ] ]
[ Columns number_of_columns ] |
[ Height frame_height [ Units paper_units ] ]
[ Region [ Height region_height [ Units paper_units ] ] ]
[ Region [ Width region_width [ Units paper_units ] ] ]
[ Line [ Width line_width [ Units paper_units ] ] ]
[ Auto Font Size { On | Off } ]
[ Order { Default | Ascending | Descending |
{ Custom id | id : id [ , id | id : id ... ] ... } } ]
[ Style [ Font... ]
[ ID { id } Text { style_name } ]
[Line Pen... | Region Pen... Brush... | Symbol Symbol... ] ]
[ , ... ]
The other clauses are not supported for layout frames.
If you omit the Window clause, the statement operates on the frontmost window, or the frontmost Legend
Designer window, or the frontmost Layout Designer window as the case may be.
Refreshing Image frames in Layout Designer windows
MapBasic programs can refresh an image frame in a Layout Designer window if the underlying image
source file has changed. The new Refresh Designer Frame statement can now be used to refresh image
frames.
Refresh Designer Frame
[Window window_id] ID frame_id [, frameID ...]
where, "window_id" is a Layout Designer window's integer window identifier.
If no window is specified the command assumes the frontmost Layout Designer
window.
"frame_id" is a number that specifies which frame within the Layout Designer
window you want to refresh. Frames are numbered 1 to n, where, n is the
number of frames in the layout.
Note: As this is a new MapBasic command it cannot be used directly in a compiled MapBasic application
using the existing 12.5 compiler. It can be used within a “Run Command” statement in a MapBasic
application or via the .Net “Do” method in an integrated mapping application.

New Coordinate Systems
New Datums added:
•
•
•
•

JGD2011 - Datum for Japan
Timbalai 1948, Everest 1968
MAGNA-SIRGAS
GDM2000

Datum parameters:
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New Entries for the Japanese Coordinate Systems
These are not included with the patch, you can add the following entries in the MAPINFOW.PRJ file
manually.
The file is located under the Tools folder where MapInfo Professional is installed (for example, under
C:\Program Files (x86)\MapInfo \Professional).
"Longitude
"Longitude
"Longitude
"Longitude

/
/
/
/

Latitude
Latitude
Latitude
Latitude

(Japan Datum 2011 JGD2011)", 1, 162
(Timbalai 1948, Modified Everest Ellipsoid)", 1, 163
(MAGNA-SIRGAS)\p4686", 1, 165
(GDM2000 Datum)", 1, 164

"Japanese Zone I (Japan Datum 2011 JGD2011)", 8, 162, 7, 129.5, 33, 0.9999,
0, 0
"Japanese Zone II (Japan Datum 2011 JGD2011)", 8, 162, 7, 131, 33, 0.9999,
0, 0
"Japanese Zone III (Japan Datum 2011 JGD2011)", 8, 162, 7, 132.166666, 36,
0.9999, 0, 0
"Japanese Zone IV (Japan Datum 2011 JGD2011)", 8, 162, 7, 133.5, 33, 0.9999,
0, 0
"Japanese Zone V (Japan Datum 2011 JGD2011)", 8, 162, 7, 134.333333, 36,
0.9999, 0, 0
"Japanese Zone VI (Japan Datum 2011 JGD2011)", 8, 162, 7, 136, 36, 0.9999,
0, 0
"Japanese Zone VII (Japan Datum 2011 JGD2011)", 8, 162, 7, 137.166666, 36,
0.9999, 0, 0
"Japanese Zone VIII (Japan Datum 2011 JGD2011)", 8, 162, 7, 138.5, 36,
0.9999, 0, 0
"Japanese Zone IX (Japan Datum 2011 JGD2011)", 8, 162, 7, 139.833333, 36,
0.9999, 0, 0
"Japanese Zone X (Japan Datum 2011 JGD2011)", 8, 162, 7, 140.833333, 40,
0.9999, 0, 0
"Japanese Zone XI (Japan Datum 2011 JGD2011)", 8, 162, 7, 140.25, 44,
0.9999, 0, 0
"Japanese Zone XII (Japan Datum 2011 JGD2011)", 8, 162, 7, 142.25, 44,
0.9999, 0, 0
"Japanese Zone XIII (Japan Datum 2011 JGD2011)", 8, 162, 7, 144.25, 44,
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0.9999, 0, 0
"Japanese Zone XIV (Japan Datum 2011 JGD2011)", 8, 162, 7, 142, 26,
0, 0
"Japanese Zone XV (Japan Datum 2011 JGD2011)", 8, 162, 7, 127.5, 26,
0, 0
"Japanese Zone XVI (Japan Datum 2011 JGD2011)", 8, 162, 7, 124, 26,
0, 0
"Japanese Zone XVII (Japan Datum 2011 JGD2011)", 8, 162, 7, 131, 26,
0, 0
"Japanese Zone XVIII (Japan Datum 2011 JGD2011)", 8, 162, 7, 136,
0.9999, 0, 0
"Japanese Zone XIX (Japan Datum 2011 JGD2011)", 8, 162, 7, 154, 26,
0, 0
"--"UTM
0
"UTM
0
"UTM
0
"UTM
0
"UTM
0
"UTM
0
"UTM
0

0.9999,
0.9999,
0.9999,
0.9999,
20,
0.9999,

Universal Transverse Mercator (Japan Datum 2011 JGD2011) ---"
Zone 51 (Japan Datum 2011 JGD2011)", 8, 162, 7, 123, 0, 0.9996, 500000,
Zone 52 (Japan Datum 2011 JGD2011)", 8, 162, 7, 129, 0, 0.9996, 500000,
Zone 53 (Japan Datum 2011 JGD2011)", 8, 162, 7, 135, 0, 0.9996, 500000,
Zone 54 (Japan Datum 2011 JGD2011)", 8, 162, 7, 141, 0, 0.9996, 500000,
Zone 55 (Japan Datum 2011 JGD2011)", 8, 162, 7, 147, 0, 0.9996, 500000,
Zone 56 (Japan Datum 2011 JGD2011)", 8, 162, 7, 153, 0, 0.9996, 500000,
Zone 57 (Japan Datum 2011 JGD2011)", 8, 162, 7, 159, 0, 0.9996, 500000,

New Projections
• 35 – Added support for Rectified Skewed Orthomorphic projection used in Malaysia.

New Entries for the Malaysian Coordinate Systems
These are not included with the patch, you can add the following entries in the MAPINFOW.PRJ file
manually.
The file is located under the Tools folder where MapInfo Professional is installed (for example, under
C:\Program Files (x86)\MapInfo \Professional).
"Peninsular RSO GDM2000 Datum", 35, 164, 7, 102.25, 4, 323.025796466667,
323.130102361111, 0.99984, 804671, 0
"Peninsular RSO Kertau Datum", 35, 47, 7, 102.25, 4, 323.025796466667,
323.130102361111, 0.99984, 804671.2996, 0
"East Malaysia (BRSO) GDM2000 Datum", 35, 164, 7, 115, 4, 53.31582047,
53.13010236, 0.99984, 0, 0
"East Malaysia (BRSO) Timbalai Datum", 35, 163, 7, 115, 4, 53.31582047,
53.13010236, 0.99984, 0, 0

Using the New Help System
MapInfo Professional, MapBasic, and ProViewer software come with a new Help System viewer. For
details about using the new viewer, see the notes that come with it by double-clicking the assistant.exe
file located under the QT folder where MapInfo Professional is installed (for example, under C:\Program
Files (x86)\MapInfo\Professional\QT).
To view the Help System outside of the software:
1. Launch the Command Prompt.
From the Start menu type Command Prompt in the search box, or on Windows 8 swipe to the Apps
screen and look under Windows System.
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2. Change directories to the QT folder. As an example:
cd C:\Program Files (x86)\MapInfo\Professional\QT
3. Type the following, but replace the path with your installation location:
assistant.exe –collectionFile C:\Program Files
(x86)\MapInfo\Professional\MapInfoProfessional.qhc
Ensure that you type .qhc as the file extension for the collectionFile input. Depending on the
product help that you want to view, you would type the path to MapInfoProfessional.qhc,
MapBasic.qhc, or MIProViewer.qhc.
To view the help on another machine, copy the QT folder, and the .qhc and .qch files, from the software
installation folder to the machine you want to view the help on. Both .qhc and .qch files must be in the
same folder for the viewer to open the Help System.
Tip: Consider creating a batch (.bat) file that you can double-click to invoke the Help System. The
file will contain a single command: C:\Program Files
(x86)\MapInfo\Professional\QT\assistant.exe –collectionFile C:\Program
Files (x86)\MapInfo\Professional\MapInfoProfessional.qhc

Known Issues
Editing Text in the Layout Designer Window
There is a Microsoft issue that affects editing text in the Layout Designer window. The mouse cursor
may disappear in a text frame when the Layout Designer zoom value is not set to 100%. Resetting the
zoom value to 100% should correct this issue, which only happens intermittently.
License Server Utility Incorrect Dates
When the RESERVE option is used in the options file (unisw20.opt located in the License Server Utility
installation directory), the licenses are checked out from the License Server Utility with incorrect start
dates.
Printing to PDF
When printing to PDF, the printing progress window may appear frozen and clicking Cancel can cause
MapInfo Professional to halt.
Selecting certain non-default PDF preferences causes this issue. If you experience this issue, change
the PDF preferences back to their default settings:
1. On the File menu, point to Print to PDF to open the Print dialog box.
2. Click Properties to open the MapInfo PDF Printer Properties dialog box.
3. On the Destination tab, uncheck the Prompt for Destination check box.
Running PolyBuilder in MapInfo Professional 12.0 and 12.5
When MapInfo Professional 12.0 and 12.5 are on the same machine, MapInfo Professional 12.0 closes
unexpectedly when running the PolyBuilder tool. The issue persists after you uninstall MapInfo Professional
12.5.
To run PolyBuilder in version 12.0 after installing version 12.5:
1. Launch the command prompt with administrator privileges.
2. Navigate to the directory where MapInfo Proffessional 12.0 is installed, for example:
cd C:\Program Files (x86)\MapInfo\Professional
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3. Run MapInfo Professional 12.0 with the following option:
Mapinfow.exe -regserver

Progress and Resolution of Outstanding Issues
MapInfo Professional
Issue Number

Description and Resolution

MIPRO-39353

Exporting a map with translucent layer using bitmap fill patterns sometimes does
not export colors correctly.
Resolution: Fixed. The exported images, from Save Window As, now look as
good as they appear on the screen.

MIPRO-42466

Error opening a WFS-Service in MapInfo Professional.
We write a WFS Table Description file (which uses an XML file type) to go along
with the TAB file. The file contains information about the server, tables on the
server, columns, and any filters used. Due to an XML namespace issue, the
Microsoft DOM reader (and in turn MapInfo Professional) is unable to read the
file.
Resolution: Fixed.

MIPRO-50913

The default output format for the DescribeFeatureType request (which returns a
schema with the table structure) was changed between WFS 1.0 and 1.1. We
were correctly using the new default if the server supports POST requests, but
not if the server only supports GET requests. If the server also only supports
WFS 1.1 and not the older schema format, it can produce an error.
Resolution: Fixed.

MIPRO-45949

Oracle Spatial 12c - Do not show the index tables of type MDXT% in the Open
DBMS Table dialog box.
Resolution: Fixed.

MIPRO-41165

Inaccuracy in Ruler Tool when zooming in/out.
The issue with calculating the first point position to display the distance result in
the ruler tool as been fixed. We now calculate the position of all points identically,
which produces more consistent results.
Resolution: Fixed.

MIPRO-37789

If the cutter/target object has some polygons with 3 points, the exterior polygons
were not getting correctly classified and some object processing operations like
overlap calculations and erase were giving incorrect results.
Resolution: Fixed.

MIPRO-49806

The MWS file with an empty BitMap XML element created with MapXtreme
Workspace manager, fails to open in MapInfo Professional.
Resolution: Fixed.

MIPRO-43994

In some cases, MapInfo Professional does not show any data for columns type
nchar and nvarchar from SQL Server tables.
Resolution: Fixed.
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Issue Number

Description and Resolution

MIPRO-56808

Printing of transparent bitmap fill patterns to PrintOSBM.
Improved print quality of bitmap fill patterns for transparent backgrounds. This
applies for the Map windows that are being printed using the "Print using
Off-Screen Bitmap (OSBM)" print method, or for map frames in a Layout Designer
window when the Map has enhanced rendering turned on. The bitmap fills should
look similar to the quality of the non-transparent bitmap fills, except that the
background is transparent.
Resolution: Fixed.

MIPRO-56815

Provide option to print bitmap fill pattern without smoothing.
Added the ability to control whether bitmap fill patterns appear smooth or not
when printed using the Print OSBM print method. The Map Option for "Smooth
Lines & Borders" is used to specify whether to smooth the bitmap fill patterns.
Previously bitmap fill patterns were always smooth for Print OSBM.
Resolution: Fixed.

MIPRO-57147

Certain transparent bitmap fill patterns did not print properly. The output of certain
patterns looks slightly different when printed due to the addition of extra pixels
in the bitmap pattern. This is most noticeable with region fill patterns B4, D4, and
C5.
Resolution: Fixed.

MIPRO-47349

MapInfo Professional linked table issue.
MapInfo Professional did not reuse a DBMS connection when refreshing/updating
a linked table if the connection string in the linked .TAB file is modified by changing
parameters order or adding spaces. It also happened when working with a linked
table created using a connection opened by Server Connect MapBasic function
(when connection string parameters order is different from the one generated
automatically using GUI).
Resolution: Fixed.

MIPRO-44246

Update to DBMS database causes MapInfo Professional to crash.
The crash occurred when the mapcatalog had some invalid data in a column
preceding 'coordinatesystem' column (unsupported spatial type for example).
Resolution: Fixed.

MIPRO-56824

MapInfo Professioanl crashes when trying to save a link table with a disconnected
database and the user clicks cancel on “Oracle connect" dialogue when prompted
for a reconnect.
Resolution: Fixed.

MIPRO-15893

Support for MrSID Generation 4 raster files.
While opening MrSID Generation 4 raster file the image looks blurry and shows
vertical lines.
Resolution: Fixed.

MIPRO-41963

Double quotes in column content causes an ORA-01036 error in MapInfo
Professional 12.0.3
Resolution: Fixed.

MIPRO-22607

MapInfo Professioanl crashes when exporting or printing a map or a layout with
a map that contain polygons with holes.
Resolution: Fixed.
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Issue Number

Description and Resolution

MIPRO-55824

Issue with Labeling Rules / Regions / Maximum # of font sizes options for MapInfo
Professional 12 and 12.5 localized versions.
Resolution: Fixed.
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